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Getting started with the Home Control Assistant 

Congratulations, you’ve purchased the Home Control Assistant 
 

This short guide is a tutorial that covers installing the software, starting 
HCA, and creating a design for your home in three different ways.  This 
guide includes sections on how to: 
• Install the software 
• Starting HCA 
• Creating a new file with the Quick Start Wizard 
• Creating a new file with the Import Wizard 
• Creating a new file with the New Home Wizard 
• Activating HCA  

This guide is in addition to the User Guide which described all the features 
of HCA in detail. 

If you purchased the Home Control Assistant along with the interface 
hardware, you need to connect that hardware to your computer.  Details for 
this are included in the Hardware Connection Guide.  It’s a very good idea 
to install that hardware before installing HCA. 

If you already have interface hardware connected to your computer, you 
need to determine which communications port it uses. 

Hint:  Before you start installing HCA, it is a good idea to close all 
Windows-based programs. 

Install the software 
 

1. From the Windows task bar, click the Start button. 
2. Choose Settings, then Control Panel. 
3. From the Control Panel, select and open Add/Remove Programs.  
4. Click the Install button. 
5. Insert the Home Control Assistant install disk. 
6. Click Next.  
7. The Setup program will lead you through the installation process.  

 

Now that you’ve installed the software, use the rest of this guide to set up a 
new home design. 
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Start HCA 
Now the software is installed.  You’re ready to start the Home Control 
Assistant, and create your home design: 

 
1. On the Windows task bar, click the Start button. 
2. Select Program, and then Home Control Assistant. 

When you first start HCA, its main window appears on the screen.  Also in 
the system tray on the system task bar, a small HCA icon appears: 

 

 

Unlike other Windows programs you may be familiar with (word 
processors, spreadsheets, email programs), HCA must always be running on 
your computer in order for it to control your home. To make it easier to 
keep HCA running all the time and to help prevent you from inadvertently 
terminating HCA, HCA works a bit differently than these other programs. 

There are five operations that are important to understand: 
 

Maximize the HCA Window 
The HCA Window is maximized in the same manner as most Windows 
programs.  Using the left mouse button, click on the maximum button on 
the upper right hand corner of the HCA window.  The HCA window 
expands to fill the whole display. 

 

Minimize the HCA Window 
The HCA Window is minimized in the same manner as most Windows 
programs.  Using the left mouse button, click on the minimize button on the 
upper right hand corner of the HCA window.  HCA is removed from the 
display and appears in the Windows Task Bar as a button labeled with your 
home design name. 

 

Hide the HCA Window 
To hide HCA and have only the small icon in the system tray, select Exit 
from the File menu.  Unlike other programs this does not terminate HCA.  
This operation can also be done by clicking with the left mouse button on 
the close icon on the upper right hand corner of the HCA window. 
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Open the HCA Window 
To open the HCA window when HCA only appears as an icon in the 
system tray, move the mouse over the icon and click the right mouse button.  
Select Open from the popup menu. 

 

Terminate HCA 
To shutdown HCA, select Shutdown from the File menu.  This can only be 
done when the HCA menu is open.   

 
 

Using the status bar 
Across the bottom of the Home Control Assistant window is a status bar. 
The status bar provides information about what the Home Control Assistant 
is doing and what settings you have on your PC. 

 

The far left of the status bar displays the name of the device, program, or 
group icon that your pointer is placed on. 
• The state of HCA, either Active or Inactive. Clicking the left mouse 

button when over this slot switches HCA from Active to Inactive or 
Inactive to Active. 

• The current schedule you have selected, or the design has selected, 
such as At Home, or Weekend.  There can only be one schedule 
current at any time. Clicking the left mouse button when over the 
schedule slot brings up the Change Current Schedule dialog. 

• Modified.  This shows any change in the design, from adding a new 
device, to moving an icon. 

• A set of lights that shows red, yellow, or green.  Red or yellow lights 
show if the troubleshooter has found a condition that you should know 
about.  Clicking the left mouse button when over the lights brings up 
the troubleshooter dialog. 

• The hint indicator.  If HCA has a tip or idea about what you are doing 
it makes the bulb yellow and shows “Hint” next to it.  Press F1 to show 
the hint. 

• Whether the Caps lock on your keyboard is set. 
• Whether the Num Lock on your keyboard is set. 
• Either the date or the time; if you click, it toggles to the other. 
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The HINT System 
HCA contains a system that may make learning all the features of HCA a 
bit simpler.  When you are working with the HCA User Interface if your 
actions could be done in a better way, or there is a feature you may not be 
aware of, HCA displays a hint.  This can be done in one of two ways. 

First, the hint can just appear on the screen in a popup window.  Or, the 
Hint Indicator in the status bar can change to show that HCA has a hint.  In 
this case you must wither click on it or press the F1 key to show the hint. 

In the Help menu is an option to select your preference.  If Auto Hint 
Display has a checkmark next to it, hints automatically appear.  Without the 
checkbox the start bar method is used. 

On each hint popup dialog is a checkbox that you can use to have HCA no 
longer show that hint.  As you get more sophisticated you will have no need 
of some of the hints. 

If you find yourself wanting to get the hints back that you turned off, select 
Enable All Hints from the Help menu. 

 

Your Home Design 
There are two ways to begin a new home design using HCA: 
• A guided process called the Quick Start Wizard.  This wizard starts 

with a tutorial and then guides you through each room of your home 
and makes suggestions about where automation might be used.  The 
Quick Start Wizard creates a complete home design with devices, 
programs, groups, schedules, and displays. 

• A much simpler wizard, the New Home Wizard.  This wizard creates 
an empty design for you to add devices, schedule, programs, etc., using 
the various HCA wizards. 

Regardless of which of these methods is used to create a new home, there 
are two important pieces of information you’ll be asked to supply. 

Design name 

You must supply a name for your design.  This name appears in the HCA 
title bar when this design is loaded, but this need not be the file name that 
the design is stored in.  If you like, you can create several designs, each 
with a unique name, and in a different file (you may want to do this if 
you’re trying different approaches with your programs and schedules). 
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Location 

HCA uses your location to compute the sunrise and sunset times for your 
schedules. You must supply the location of your home by latitude and 
longitude.  HCA provides lists of states and major cities to choose from if 
you don’t know your longitude and latitude.  If you want a more accurate 
location, you can use one of the mapping services available on the internet.  
Or you can consult a topographic map of your area.  However, you don’t 
need to be too exact, as the difference between the computed sunrise and 
sunset and the actual sunrise and sunset times will be off by, at most, a few 
minutes if the city you select is within a hundred miles. 

HCA also relies on the time zone you have selected in the Windows control 
panel Date/Time settings tool.  If you select a city in HCA that is in a 
different time zone from the one you have set in the control panel, the 
sunrise and sunset times may appear to be off.  So, remember to check your 
control panel time zone selection. 

Hint:  Regardless of how you plan to create your home design, you may 
want to develop it on your main computer and modify it until you are 
happy with the way it runs.  Once you are sure that the design is 
complete, and that everything works correctly, you may want to 
move the Home Control Assistant, your home design file and the 
automation hardware to a smaller, less-used computer that can sit in 
a closet, or out of the way location, and just run HCA to control your 
home.  HCA was designed to run on a computer with little disk 
space, memory, and processor speed. 

HCA was designed to run on a computer with little disk space, memory, 
and processor speed. 
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The Quick Start Wizard  
The best way to begin if you are new to home automation or to HCA, is the 
Quick Start Wizard.  

The purpose of this wizard is to create the start of a home automation 
solution for your home.  The first part of the wizard is a tutorial to 
introduce you to the concepts and terms used in later steps.  The wizard 
next asks questions about your lifestyle and what rooms your home has, 
then asks you to select which lights and appliances to control.  Having 
completed that, the wizard creates the devices, programs, groups, schedules, 
and displays of a HCA design.  A report is also created showing all your 
devices, a parts list, and some installation tips. 

All homes are different, and the wizard can't anticipate all your needs.  
What is created is designed to give you a start.  After the wizard completes, 
we expect that you will modify and extend your home design to add 
additional  hardware, more programs and schedules. 

The number of steps in the wizard and the length of time to complete it 
depends upon your answers as you go along.  In the lower left corner of 
each dialog box is the current step number and the total number of steps.   

To begin a new home design with the Quick Start Wizard, click File on the 
Home Control Assistant menu bar, and then choose New and click the 
Quick Start button in the Which wizard to use dialog box. 

Once you have completed the Quick Start Wizard, the next step you should 
take is to save your design. 

To save your home design file: 
1. From the File menu, choose Save.   
2. Select the file name and location that you want and click Save. 

 

Hint: Before beginning the Quick Start Wizard, you should verify that your 
automation interfaces are connected to the computer and that it is 
working.  To do this, select Properties from the HCA menu and 
select your hardware type and connection in the Hardware tab.  The 
Test buttons verify that the interfaces are correctly connected and 
working. 

Hint: The Quick Start Wizard saves all the information that it collects from 
you each time it is used.  After you have used the Quick Start Wizard 
once, you can start over or reuse the information you entered 
previously.  If the wizard has saved information it will ask if it 
should reload that information or start anew. 
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The New Home Wizard 
On the Home Control Assistant menu bar, click File, and then choose New 
and press the New Home button in the Which wizard to use dialog. 

The New Home Wizard helps you set up the new file for your home.  
Unlike the Quick Start Wizard, this wizard creates an empty design ready 
for you to add devices, programs, schedules, etc.  

This opens the New Home Design Wizard whose first page appears as: 

 

 

Create the file 
 

1. Type in the name of your home (My home is a good choice) and click 
Next. 

2. From the State list, select your state. 
3. From the City list, select the city nearest to your home. 
4. Notice that the longitude and latitude change to match your location.  
5. Click Finish. 
Read the helpful message, and click I Understand.   
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Because the New Home Wizard creates an empty design, the next steps in 
this guide are a short tutorial to show you how to add a display with a floor 
plan background, device, schedule, and schedule entry to create a sample 
home. 

 

Create a display 
On the Home Control Assistant menu bar, click New, and then choose 
Display. This opens the New Display Wizard.   

 

1. Type Main Floor as the name for this display, and click Next. 
2. Chose the options for an Icon display and a DXF background. Click 

the Browse button, and from the designs folder, select the file that 
contains the sample house plan (My Home.DXF), and click Open.  

3. Note that the complete path to the file that you selected is displayed in 
the upper text box.   

4. In the lower text box, select the name of the application that produced 
the DXF file.  In this case, select Broderbund 3D Home Architect 2.X.   
Then click Next. 

6. On the New Display Wizard step 3, click Next. 
7. On the New Display Wizard step 4, click Next. 
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8. On step 5 of the wizard, select each item that starts with FL2, and move 
that item to the list on the right by clicking  → the right arrow button 
on the wizard. 

9. When you have moved all the FL2 items to the right list, click Finish. 
 

You now see the floor plan of the sample house. 

 

Hint:  If you have not purchased a software package for graphic floor 
plans, and do not have a DXF file, don’t despair.  HCA is a powerful 
program, with a variety of options, and makes it easy for you to add 
displays without floor plans.   
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Create a device  
To create a device within the house: On the Home Control Assistant menu 
bar, click New, and then choose Device. 

 

1. On the New Device Wizard, type Lamp as the name for this device, 
and click Next. 

2. Skip step 2 by clicking Next. 
3. On step 3 of the wizard select “LM465 Light module” from 

Manufacturer X10, then click Next. 
4. Click Next to skip steps 4, 5, and 6, until you get to step 7 of the 

wizard. 
5. On step 6 of the wizard, use the right arrow button → to move the 

Main Floor from the Displays list (left side) to the Put icon on these 
displays list (right side). 

6. Click Finish. 

Place the icon of the lamp where you want it. 

Now when you look at the Home Control Assistant you see a floor plan. In 
the upper left corner of the window you have an icon of a lamp.  You can 
drag the lamp to any place on the floor plan.  
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To move the lamp icon, use the mouse to position the pointer over the icon.  
Click and hold down the (left) mouse button, and drag the lamp to its new 
position.  

 

Now connect the lamp. 
This is a good time to connect some lamp in your home to a lamp module.  
Assign the setting of the module to A1.  It would be nice if this lamp were 
some place near your computer so you can watch it as the computer turns it 
on and off.  Before you unplug the lamp to connect it to the module, make 
sure the lamp is on.  

 

Hint:  Don’t use a fluorescent light for this demonstration–you need a 
special module for fluorescent lights. 

Now you have connected the lamp and you are back at the computer.  Move 
the mouse over the icon of the lamp and right-click.  From the popup menu, 
try turning the lamp on and off.  If it does not work, go back again and 
check all the connections to the interface hardware, the lamp module, its 
settings (should be A1), and make sure that the switch on the lamp is on. 

The next step is to set up your computer to turn the lamp on and off 
according to a schedule. 
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Create a schedule for the device 
You need to create a schedule for the lamp so that HCA can control it. 
1. On the Home Control Assistant menu bar, click New, and then choose 

Schedule. 
2. On page one of the Schedule Wizard, type the name of this schedule 

(At home is a good choice) and click Finish. 

 

 

Add a schedule entry  
Now you need to add an entry to the schedule name you have set up. 

On the Home Control Assistant menu bar, click New, and then choose 
Schedule Entry.  The Schedule Entry Wizard appears.   
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1. For Step 1, click Next. 
2. On Step 2, click the option that reads “Schedules both the time the 

device goes on and when it goes off?”.  Then click Next. 
3. On Step 3, select Every day, then click Next. 
4. On Step 4, select At, and Sunset, then click Next. 
5. On Step 5, select “Come on at Full illumination”. Then click Next. 
6. On Step 6, select At, and Sunrise, then click Next. 
7. On Step 7, check that the text reads:   

In schedule “At Home” device lamp on every day at sunset and 
off at sunrise. 

8. Then click Finish. 
 

Save the file 
Now you need to save your file. 

 
1. On the Home Control Assistant menu bar, click File, and then choose 

Save. 
2. For the File name, type in My House and click Save. 

 

That’s it!  You’ve done it.  You have a complete design—display with a 
floor plan background, device, schedule, and schedule entry.  All that 
remains is to instruct HCA to keep watching the schedule, and at the right 
time, turn things on and off.   This is covered in the Activate HCA section 
on the next page after the section on the Import Wizard. 

 
 

Activate HCA 
Before HCA does anything it is necessary for it to be Active.  When HCA is 
active the current schedule is watched to see when things should turn on or 
off.  It’s easy to activate HCA. 

But before you do, it’s necessary to select the schedule that HCA watches.  
From the Home menu, choose Set Current Schedule.  Select the schedule 
you want to be the current schedule and click OK from the displayed dialog 
box.  The status bar at the bottom of HCA displays the schedule that HCA 
is now watching.  
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Having selected the current schedule, go to the menu bar, click HCA, and 
then choose Activate HCA. 

 

Hint:  When the Home Control Assistant is active, the menu entry toggles 
to read Deactivate HCA. 

 

Now sit back and wait for sunset to see if your light goes on.   

Do you need to know when HCA is going to do something, or when 
Sunrise or Sunset is?  From the Home Control Assistant menu bar, click 
HCA and choose Status.  

 

Note the time of sunset today and how it is different tomorrow. 
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User Guide Quick Reference 
Here is a quick reference guide to what User Guide chapter covers which 
commands.   

 
Menu Item Chapter 

Home   
 House and Unit Code 

Inventory 
Chapter 15 

 Program Flag Inventory Chapter 15 
 Set Current Schedule Chapter 6 
 Open Date Book Chapter 13 
 Open Icon Gallery Chapter 14 
 Periodic Status Export Chapter 16 
 Export Design Elements Chapter 17 
 Import Design Elements Chapter 17 
 Properties Chapter 3 
   
New Device Chapter 5 
 Program Chapter 9 
 Group Chapter 8 
 Schedule Chapter 6 
 Schedule Entry Chapter 6 
 Controller Chapter 10 
 Display Chapter 4 
 Visual Scheduler Chapter 7 
 Occupancy Wizard Chapter 6 
   
Smart Devices   
 KeypadLinc Setup Appendix 8 
 SwitchLinc Scene Setup Appendix 8 
 TempLinc Setup Appendix 9 
 Lightolier Scene Setup Appendix 8 
 PCS Scene Setup Appendix 8 
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 Wireless Component 
Inventory 

Appendix 12 

 Weather Provider Setup Appendix 10 
 Protocol Bridges Appendix 16 
 Global Cache Setup Appendix 17 
   
UPB   
 Open UPB Monitor Appendix 14 
 UPB Network Import Appendix 14 
 UPB Network Setup Appendix 14 
   
Insteon Network Capture Databases Appendix 15 
 Network Clean Appendix 15 
 Network Map Appendix 15 
 Device Replace Appendix 15 
 Multi-Way Wizard Appendix 15 
 Visual Scene Editor Chapter 18 
   
HCA Activate Chapter 6 
 Status  
 Hardware -Setup Appendix 1 
 Hardware - CM11 Appendix 2 
 Hardware - HouseLinc Appendix 5 
 Hardware – Insteon Appendix 15 
 Hardware – Lightolier Appendix 4 
 Hardware – LynX-10PLC Appendix 6 
 Hardware – LynX-PORT Appendix 6 
 Hardware – Magic Module Appendix 3 
 Hardware – Wireless Appendix 12 
 Hardware – PowerLinc Appendix 14 
 Properties Chapter 2 
   
Troubleshooter   
 Open Troubleshooter Chapter 11 
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 Open Log Viewer Chapter 11 
 X10 Test Chapter 11 
 Open Comm Monitor Chapter 11 
   
Help   
 User Guide Chapter 19 
 User Guide Appendix Chapter 19 
 Technical Support Chapter 19 
 Show Current Hint Chapter 1 
 Auto Hint Display Chapter 1 
 Enable All Hints Chapter 1 

 

Final Points 
Now you’ve walked through the process of setting up a file.  Before 
creating your own home file, it might be a good idea to look at some of the 
other aspects of HCA that we haven’t yet covered.  The HCA online help 
file contains lots of useful information.  

You also may want to load the sample home that comes with HCA and see 
various ways that HCA can automate your home.  This design can be found 
in the Designs folder with the name “MyHome.HCA.”  

web tip:  For more information about the sample home, there is a technical 
note on the support web site that describes its devices, groups, 
and programs. 

Finally, a really great place to get information is the support web site.  
Links to the web site are in the dialog displayed when Technical Support is 
selected from the Help menu. 
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